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Vivien 2011  
Release Notes 

March 2011 
Thank you for installing Vivien 2011. These release notes provide the most up-to-date 
information about content and fixes made to the application.  

 

To Help You Get Started with Vivien 

To help you get started using Vivien, a number of sample files and various 
documentation sources are available for your use.  

 
Documentation sources 

Documentation sources are available in several locations for your convenience: 

 from the Vivien Install panel during installation 

 on the Vivien 2011 CD (in the \Support Documentation folder) 

 from the Start>Programs>Vivien 2011 shortcut menu (once Vivien has been 
installed) 

 from the Vivien Web site http://www.viviendesign.com/ 

Sources include: 

 User’s Guide 

 Getting Started Guide 

 Release Notes  

Sample files 

Sample Vivien files are provided with the installation for you to use as examples or 
references. These files can be found in the \Samples folder where you installed Vivien 
(for example, C:\Program Files\Vivien 2011\Samples).  

 
Vivien Virtual Event Designer compatibility with wysiwyg 

Vivien is fully compatible with CAST Software’s award-winning lighting design software 
suite, wysiwyg. You can create your events in Vivien and then open the files in wysiwyg 

if you want to add even more sophisticated lighting effects. 

You can use Vivien Virtual Event Designer to increase your planning efficiency. Vivien is 
the sales, planning, design, and production tool designed for the meeting and special 
events industry. Once you have created your event in Vivien, you can share your file 
with a Lighting Designer who can open it in wysiwyg. In this way, you can exchange 

ideas and share updates to your files, taking advantage of the file compatibility between 
Vivien and wysiwyg.  

http://www.viviendesign.com/
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While Vivien deals with the venue, wysiwyg deals with the stage. However, both wysiwyg 

and Vivien: 

 Feature simplified CAD tools to plot or lay out floor spaces or lighting plans 

 Deliver photorealistic renderings of these drawings 

 Contain 1000s of library objects designed for the industry 

 Share the same reliable, robust base code 

 Deliver eye-popping visuals 

 Provide Wizards for common tasks 

 

Recommended system requirements (for general Vivien usage) 

 Intel Core Duo or compatible processor, 2.0 Ghz or better  

 Windows XP with Service Pack 3 (or later) or Windows Vista with Service Pack 1 
(or later) 

 MAC Intel Processor platforms with Windows XP (SP3 or later) or Windows Vista 
(SP1 or later) (on Bootcamp configuration or with Parallels software installed) 

Note: When running Vivien on a MAC with Bootcamp, performance is 
comparable to running Vivien on a PC. When running Vivien on a MAC in 
Parallels, performance is slightly degraded when compared to a PC. 

 2048MB or 2GB RAM 

 1024MB or 1GB free disk space (NTFS file system) 

 1024 x 768 or better resolution  

 PCI Express Video Card with OpenGL-accelerated display adapter with 256MB 
(or better) video memory 

 OpenGL 2.0 Support for new visualization 

 USB port for dongle security 

High performance system requirements (for best response and rendering time) 

 Multi-CPU Computer or better with Multi-Core processor technology, Intel 
Dual/Quad Core or AMD Opteron 

 Windows XP with Service Pack 3 (or later) or Windows Vista with Service Pack 1 
(or later) 

 MAC Intel Processor platforms with Windows XP (SP3 or later) or Windows Vista 
(SP1 or later) (on Bootcamp configuration or with Parallels software installed) 

Note: When running Vivien on a MAC with Bootcamp, performance is 
comparable to running Vivien on a PC. When running Vivien on a MAC in 
Parallels, performance is slightly degraded when compared to a PC. 

 4096MB or 4GB RAM or greater 

 1024MB or 1GB free disk space (NTFS file system) 

 1024 x 768 or better resolution  
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 PCI Express Video Card with OpenGL-accelerated display adapter with 512MB 
(or better) video memory 

 OpenGL 2.0 Support for new visualization 

 USB port for dongle security 

 

Video card requirements to display Enhanced Beams 

To display our beam simulation in the Virtual Views, the video card requirements have 
changed for Vivien 2010 and beyond. Our new simulation feature takes advantage of 
advanced graphical technologies available only in OpenGL 2.0. As a result, your 
computer must have a video card that supports OpenGL 2.0 to run the latest version of 
Vivien with its enhanced features. If you do not have this type of card, a warning appears 
and the Enhanced Simulation option will not be available. However, you will still be able 
to run the software and visualize the beams with our original beam representation. 

Additionally, for renderings to complete sooner/quicker, a faster, multi-core processor is 
recommended. Recommended processors include, but are not limited to, Intel Core2 
Duo, Intel Core2 Quad, Intel Core i7, AMD PhenomII X2 and AMD Phenom II X4. 

 

Hard drive compatibility 

Due to restrictions in file name length, you cannot install Vivien on a FAT32-formatted 
hard drive. Instead, you must install the product on an NTFS-formatted hard drive. For 
details, see http://www.viviendesign.com/howto.html?tab=Installation_Note. 

 

Dongle security 

From time to time, CAST updates its security protocol to protect its intellectual property 
and the investment of its End Users. To that end, we have improved the security of our 
Vivien product, replacing Vivien’s soft security solution with a hard security dongle 
solution.  

Your dongle is not only the key to open your Vivien software, but it also carries a security 
protocol and other information embedded on it that establishes you as the registered 
licensee (thus protecting your investment).  

The dongle security system also provides more flexibility to you, the user, because your 
Vivien license is stored on the dongle and can travel from one computer to another. With 
a portable Vivien license, you can work on whichever computer you need to use: office, 
home, or laptop. 

Finally, this new dongle security system works on 64-bit Windows operating systems 
which now means you can install and use Vivien 2011 on these computer platforms.  

NOTE: Existing Vivien customers who wish to obtain Vivien 2011 must transfer the soft-
security license for a hard-security dongle. The process of transferring your existing 
serial code for a dongle with a new security code uses the Vivien Licensing Transfer 

http://www.viviendesign.com/howto.html?tab=Installation_Note
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Utility (VLTU), as described below. Please contact CAST Software for information about 
obtaining a dongle to start using Vivien 2011. 

 

Vivien Licensing Transfer Utility (VLTU) 

Customers who upgrade their Vivien membership to become eligible to use Vivien 2011 
will receive a small, plastic device that plugs into the USB port of your computer called a 
dongle. (To work with Vivien 2011, you must plug your dongle into your computer every 
time you run Vivien.) This dongle is accompanied by a software installer that will install 
the VLTU on your computer.  

General steps for transferring your existing Vivien license to Vivien 2011 

Note: You must install the VLTU on the computer on which your old version of Vivien is 
installed.  

1. Before you plug the dongle into your computer, install the VLTU from the 
installation CD that you received with the dongle.  

2. Once the VLTU installation is complete, ensure that the computer is connected to 
the Internet (a requirement for the utility to work). 

3. Plug the dongle into a USB port on your computer. 

4. Run the VLTU by double-clicking its icon on your desktop. 

5. Follow the instructions in the utility. As it runs, it will deactivate your old version of 
Vivien. 

6. When prompted by the utility, insert the new dongle received and continue. The 
VLTU will transfer your license to the new dongle plugged into the USB port.  

7. Once the VLTU process is complete, start Vivien 2011 with the dongle plugged 
in.  

8. Follow the prompts to register your new dongle. If this automated process fails, 
you must contact CAST Software Technical Support to register your new dongle. 

Toll-Free Tel: +1.877.989.2278 / Email: techsupport@cast-soft.com 

 

New in Vivien 2011 

Vivien 2011 contains the following new or enhanced features: 

New Features 

General Features 

 Video Playback: Vivien 2011 enables you to play back video on various 

screens. You can: 

o Embed video on Projector Screens created through the Projection Wizard 

o Attach video to AV objects (such as Plasma Screens and Projection 

Screens) 
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o Project video using special AV equipment (Small, Medium, and Large 

Projector) 

 Environmental Lighting Tool: This new designer tool enables you to modify the 

ambient and time of day settings in the Lighting Quad and Virtual View tabs. 

 Text toolbar:  Using the new Text toolbar, you can adjust the font style, font 

size, and text alignment of a selected text label. You can access this toolbar in 

the Drawing Wireframe/Quad and Layouts tabs. 

 Alignment toolbar:  The Alignment toolbar enables you to align selected objects 

with the click of a button in the Drawing Wireframe/Quad and Layouts tabs.  

 PDF Printing:  Vivien 2011 comes with a specialized PDF printer that enables 

you to save files in PDF format. This option is available in the Spreadsheet and 

Layouts tabs. 

 Support for AutoCAD 2010 DWG/DXF: Vivien 2011 supports the import and 

export of AutoCAD 2010 DWG/DXF files. 

 Support for SketchUp 8.0:  Vivien 2011 supports the import of SketchUp 8.0 

files. 

 Vivien User Data (*.vud) Files: Vivien settings that are specific to a particular 

installation of the Vivien software can be saved in an eternal file with a .vud 

extension. This file can be loaded by Vivien 2011 and beyond to reload user 

settings saved in the .vud files. Using .vud files, you can share your custom user 

data between multiple computers, and when upgrading to newer versions of 

Vivien. 

You can save the following user settings in a .vud file: 
o Custom Gobos 

o Custom Library Items 

o Toolbar Positions 

Drawing Wireframe/Quad Enhancements 

 Send to back/front enables you to manipulate the draw order for various 

Wireframe items. 

 Convert lines into surfaces.  This feature enables you to take any line and 

extrude it into a surface. This tool can be found on either of the Drawing tabs 

under Modify > 3D Transform > Lines into Surfaces. 

Note: If the line is not closed, this operation will close it by connecting the start 

and end points. 

 The Shape tool enables you to create polygons of various shapes and sizes. 

You can access this tool on either of the Drawing tabs under Draw > Shape. 

 New Dimension Tools  

Vivien 2011 offers the following new dimension tools: 

o Arc Length 

o Radial 

o Protractor 
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From the Draw menu, you can now add information about arcs and circles using 

the new Arc Length and Radial dimension tools. After drawing a circle or arc in 

your file, select it, and then click the appropriate option from the Draw menu to 

add these new dimensions to your file. To find out more about the new dimension 

tools, please refer to the Vivien User Guide. 

 Cycle Selection: This feature enables you to select an object that shares an 

edge with another object. To activate Cycle Selection, press SHIFT before 

clicking to select. When Cycle Selection is active, Cycle On appears in the Vivien 

Status Bar. To select the object, you must click on a spot where two or more 

lines overlap or intersect. To continue selecting, keep pressing SHIFT to cycle 

through all items that share the area where you clicked.   

Virtual View Enhancements 

 Improved Camera Controls:  Improved camera controls enable you to do the 

following:  

o Lock the current camera to prevent accidental movement 

o Save the existing view in Virtual Views as a new camera 

o Switch between cameras using numerical hotkeys 

 3Dconnexion compatibility Vivien is now compatible with 3D mice 

manufactured by 3Dconnexion. When used in conjunction with Vivien, the 

3Dconnexion mouse gives you full Virtual View control in 6 Degrees of Freedom. 

Lighting Design Tools 

 Pan/Tilt lock in the Light Tool enables you to restrict fixture movement to a 

particular axis when using the Focus trackpad. Note that this restriction only 

applies to the trackpad itself and will not prevent the clicking and dragging of the 

beam in any direction in a Wireframe view. 

Layouts Enhancements 

 Lock Object: You can now lock any object to avoid accidently moving it once it’s 

in place. To lock an object, select it and click Modify > Lock.  

Spreadsheet Enhancements 

 Import/export worksheets from/to MS Excel 2007/2003/2000/XP/etc. format. 

Vivien 2011 offers support for XLS, XLSX, and CSV file formats.  

 Cell Formatting of common cell categories is now available, including Number, 

Currency (top currencies around the world and their symbol supported), Date, 

Time, Percentage, and Scientific. 

 You can insert images into spreadsheet cells. 

 You can add cell borders to divide sections of the worksheet and improve its 

appearance and legibility.  

 There is a new Text formatting toolbar on the Spreadsheet tab to simplify text 

formatting. 

 Column sorting is now available (ascending/descending). 
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 You can use smart cells to introduce a drop-down list in the current worksheet 

cell containing all of the available variables for the show. When the cell is 

selected, a drop-down appears displaying potential variables (taken from 

Document Options > Event Info). When a variable is selected, the corresponding 

text defined in the Document Options is displayed in the cell (for example: Event, 

Client, etc.).  

 Formulae: Over 100 formulae for common mathematical and logic functions are 

supported (formulae must be manually entered). Examples of formulae include:  

ABS:  determines the absolute value of the specified value, cell or expression    
Example: =ABS(-4) gives output 4 
 
AVERAGE: finds the averages of a list of values.   
Example: =AVERAGE(1,2,3,4,5) gives output 3 
 
CEILING: rounds a number up to the nearest multiple of the specified value.  
Example: =CEILING(-2.3, -1) rounds to the closest whole number in the 
negative range, gives output -3 
 
FLOOR: rounds a number down to the nearest multiple of the specified 
value.  
Example: =FLOOR(2.3, 1) rounds to the closest whole number in the positive 
range, gives output 3 
 
MAX: returns the maximum value from a given list of values. 
Example: =MAX(1,2,3,4,5) gives 5 

 
MEDIAN: returns the median, or the number in the middle of the provided set 
of numbers. 
Example: =MAX(1,2,3,4,5) gives 3 
 
MIN: returns the minimum value from a given list of values. 
Example: =MIN(1,2,3,4,5) gives 1 
 
SUM: returns the sum of cells or range of cells. 
Example: =SUM(1,2,3,4,5) gives output 15 

 

 

Library Additions Vivien 2011 
 

Total Library Additions: 

Fantastic Backdrops 637 items  

Textures 21 items  

Office Accessories 5 items 
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Furniture from CORT 251 items 

AV Items 2 items 

Rose Brand fabrics 47 items 

Total Items 866 Items 

 

The following additions were made to the library in the Vivien 2011: 

Path Name 

Manufacturer > Manufacturer > CORT 
Event Furnishings -> Accessories Acrylic Table Lamp 

 Angle Table Lamp 

 Blue Trovato LED Floor Lamp 

 Brady Table Lamp 

 Espresso 12x12 Accent Pillow 

 Espresso 12x20 Accent Pillow 

 Espresso 16x16 Accent Pillow 

 Ficus Tree 

 Filigree 18x18 Accent Pillow 

 Green Trovato LED Floor Lamp 

 Henna 11x21 Accent Pillow 

 Jewel Citrine 12x16 Pillow 

 Jewel Orange 12x16 Pillow 

 Jewel Pink 12x16 Pillow 

 Luxury White 12x20 Accent Pillow 

 Luxury White 14x14 Accent Pillow 

 Luxury White 16x16 Accent Pillow 

 Midnight Organza 12x12 Accent Pillow 

 Midnight Organza 12x20 Accent Pillow 

 Midnight Silver and Black 12x20 Accent 
Pillow 

 Midnight Silver and Black 14x14 Accent 
Pillow 

 Midnight Silver and Black 16x16 Accent 
Pillow 

 Orange Trovato LED Floor Lamp 

 Paprika 18x18 Accent Pillow 

 Parisian Pewter Table Lamp 

 Pewter Floor Lamp 

 Phoenix Palm 

 Pink Trovato LED Floor Lamp 

 Red Trovato LED Floor Lamp 

 Reeds 18x18 Accent Pillow 

 Rust 12x12 Accent Pillow 

 Rust 12x12 Accent Small Pillow 
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Path Name 

 Rust 16x16 Accent Pillow 

 Sage 18x18 Accent Pillow 

 Silver Geo 18x18 Accent Pillow 

 Starlet Bronze 16x16 Accent Pillow 

 Starlet Red 16x16 Accent Pillow 

 Starlet Teal 16x16 Accent Pillow 

 White Trovato Floor Lamp 

 Yellow Trovato LED Floor Lamp 

Manufacturer -> Manufacturer -> 
CORT Event Furnishings -> Barstools Black Lift Barstool 

 Black Ohio Barstool 

 Gin Maple Barstool 

 Grey Ohio Barstool 

 Jam Barstool 

 Red Lift Barstool 

 Red Ohio Barstool 

 White Lift Barstool 

Manufacturer -> Manufacturer -> 
CORT Event Furnishings -> Club 
Chairs Astro Chair 

 Lisbon Chair 

 Memphis Chair 

 Ray Chair 

Manufacturer -> Manufacturer -> 
CORT Event Furnishings -> 
Conference Chairs Altura Drafting Stool 

 Altura Guest Chair 

 Altura Highback Executive Chair 

 Altura Midback Executive Chair 

 Altura Steno Stool 

Manufacturer -> Manufacturer -> 
CORT Event Furnishings -> Endless 
Seating Endless Seating Black Curved Seat 

 Endless Seating Black Large Curve High 
Back Chair 

 Endless Seating Black Large Curve Low 
Back Chair 

 Endless Seating Black Small Curve High 
Back Chair 

 Endless Seating Black Small Curve Low Back 
Chair 

 Endless Seating Black Square High Back 
Chair 

 Endless Seating Black Square High Back 
Loveseat 

 Endless Seating Black Square High Back 
Sofa 
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Path Name 

 Endless Seating Black Square Low Back 
Chair 

 Endless Seating Black Square Low Back 
Loveseat 

 Endless Seating Black Square Low Back 
Sofa 

 Endless Seating Black Square Seat 

 Endless Seating White Large Curve High 
Back Chair 

 Endless Seating White Large Curve Low 
Back Chair 

 Endless Seating White Small Curve High 
Back Chair 

 Endless Seating White Small Curve Low 
Back Chair 

 Endless Seating White Square High Back 
Chair 

 Endless Seating White Square High Back 
Loveseat 

 Endless Seating White Square High Back 
Sofa 

 Endless Seating White Square Low Back 
Chair 

 Endless Seating White Square Low Back 
Loveseat 

 Endless Seating White Square Low Back 
Sofa 

 Endless Seating White Square Seat 

Manufacturer -> Manufacturer -> 
CORT Event Furnishings -> 
Occasional Chairs Beige Stage Chair 

 Black Madrid Chair 

 Black Stage Chair 

 Camel Stage Chair 

 Cappuccino Chair 

 Espresso Meeting Chair 

 Green Fusion Chair 

 Harley Wing Back Chair 

 Kiss Glitter Chair 

 Mirabel Chair 

 Red Fusion Chair 

 Red Stage Chair 

 Taupe Meeting Chair 

 White Madrid Chair 

Manufacturer -> Manufacturer -> 
CORT Event Furnishings -> Office Mahogany Bookcase 

 Graphite Bookcase 

 Mahogany Lateral File 
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Path Name 

 Graphite Lateral File 

 Mahogany Credenza 

 Graphite Storage Credenza 

 Grey 2-Drawer Vertical File 

 Grey 4-Drawer Vertical File 

 Graphite Executive Desk 

 Graphite Parson Writing Desk 

 Mahogany Executive Desk 

Manufacturer -> Manufacturer -> 
CORT Event Furnishings -> Ottoman Black 40x40 Square Ottoman 

 Black and Red Pinwheel Ottoman 

 Black and White Leather Circle Ottoman 

 Black Candy Ottoman 

 Black Cube Ottoman 

 Black Leather Bench Ottoman 

 Black Leather Circle Ottoman 

 Black Leather Half Round Ottoman 

 Black Leather Oval Ottoman 

 Blueberry Cube Ottoman 

 Endless Seating Black Round Ottoman 

 Endless Seating Curved White Ottoman 

 Endless Seating White Round Ottoman 

 Lemon Cube Ottoman 

 Orange Candy Ottoman 

 Raspberry Cube Ottoman 

 Ray Ottoman 

 Red Candy Ottoman 

 White 40x40 Square Ottoman 

 White Cube Ottoman 

 White Leather Bench Ottoman 

 White Leather Circle Ottoman 

 White Leather Half Round Ottoman 

 White Leather Oval Ottoman 

 White, Black and Red Pinwheel Ottoman 

Manufacturer -> Manufacturer -> 
CORT Event Furnishings -> Soft 
Seating Astro Sofa 

 Lisbon Loveseat 

 Lisbon Sofa 

 Meridian Loveseat 

 Meridian Sofa 

 Mini Memphis Sofa 

 Mirabel Sofa 

 Newport Sofa 

 Ray Sofa 
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Path Name 

Manufacturer -> Manufacturer -> 
CORT Event Furnishings -> Stacking 
Chairs 

Black Berlin Stacking Chair 

 Iso Mesh Chair 

 Red Berlin Stacking Chair 

 Syntax Stacking Chair 

 T-Vac Chair 

 Vista Stacking Chair 

Manufacturer -> Manufacturer -> 
CORT Event Furnishings -> Tables -> 
Bar Tables Orange Bar Table with Black Base 

 Purple Bar Table with Black Base 

 Maple Bar Table with Black Base 

 Mahogany Bar Table with Black Base 

 Liquid Black Bar Table with Black Base 

 Liquid White Bar Table with Black Base 

 Brushed Red Bar Table with Black Base 

 Brushed Blue Bar Table with Black Base 

 Orange Bar Table with Tulip Chrome Base 

 Purple Bar Table with Tulip Chrome Base 

 Maple Bar Table with Chrome Base 

 Mahogany Bar Table with Tulip Chrome Base 

 Liquid Black Bar Table with Tulip Chrome 
Base 

 Liquid White Bar Table with Tulip Chrome 
Base 

 Brushed Red Bar Table with Chrome Base 

 Brushed Blue Bar Table with Chrome Base 

 Granite Bar Table with Black Base 

 Granite Bar Table with Tulip Chrome Base 

 Graphite Bar Table with Black Base 

 Graphite Bar Table with Chrome Base 

 Metallic Silver Bar Table with Black Base 

 Metallic Silver Bar Table with Chrome Base 

 Graphite Nebula Bar Table with Black Base 

 Graphite Nebula Bar Table with Chrome 
Base 

 Grey Nebula Bar Table with Black Base 

 Grey Nebula Bar Table with Chrome Base 

 Square Brown Bar Table with Black Base 

 Square Brown Bar Table with Chrome Base 

 Square White Bar Table with Black Base 

 Square White Bar Table with Chrome Base 

 Rectangle Brown Bar Table with Black Base 

 Rectangle Brown Bar Table with Chrome 
Base 

 Rectangle White Bar Table with Black Base 
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Path Name 

 Rectangle White Bar Table with Chrome 
Base 

 Graphite Nebula Cafe Table with Black Base  

 Graphite Nebula Cafe Table with Tulip 
Chrome Base  

Manufacturer -> Manufacturer -> 
CORT Event Furnishings -> Tables -> 
Cafe Tables Granite Cafe Table with Black Base  

 Granite Cafe Table with Tulip Chrome Base  

 Mahogany Cafe Table with Black Base  

 Mahogany Cafe Table with Tulip Chrome 
Base  

 Maple Cafe Table with Black Base  

 Maple Cafe Table with Tulip Chrome Base  

 Orange Cafe Table with Black Base  

 Orange Cafe Table with Tulip Chrome Base  

 Purple Cafe Table with Black Base  

 Purple Cafe Table with Tulip Chrome Base  

 Brandy Cafe Table with Black Base  

 Brandy Cafe Table with Tulip Chrome Base  

 Brushed Blue Cafe Table with Black Base  

 Brushed Blue Cafe Table with Tulip Chrome 
Base  

 Brushed Red Cafe Table with Black Base  

 Brushed Red Cafe Table with Tulip Chrome 
Base  

 Liquid Black Cafe Table with Black Base  

 Liquid Black Cafe Table with Tulip Chrome 
Base  

 Metallic Silver Cafe Table with Black Base  

 Metallic Silver Cafe Table with Tulip Chrome 
Base  

 Liquid White Cafe Table with Black Base  

 Liquid White Cafe Table with Tulip Chrome 
Base  

 Square Brown Cafe Table with Black Base 

 Square Brown Cafe Table with Chrome Base 

 Square White Cafe Table with Black Base 

 Square White Cafe Table with Chrome Base 

 Rectangle Brown Cafe Table with Black Base 

 Rectangle Brown Cafe Table with Chrome 
Base 

 Rectangle White Cafe Table with Black Base 

 Rectangle White Cafe Table with Chrome 
Base 

Manufacturer -> Manufacturer -> 
CORT Event Furnishings -> Tables -> 
Cocktail Tables Meridian Cocktail Table with Green Glass 
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Path Name 

 Meridian Cocktail Table with Orange Glass 

 Orange Nesting Cocktail Tables 

 Purple Nesting Cocktail Tables 

Manufacturer -> Manufacturer -> 
CORT Event Furnishings -> Tables -> 
Conference Tables 42'' Round Graphite Conference Table 

 42'' Round Grey Conference Table 

 42'' Round Mahogany Conference Table 

 6ft Graphite Conference Table 

 6ft Grey Conference Table 

 8ft Graphite Conference Table 

 8ft Grey Conference Table 

 Square Round Chrome Geo Conference 
Table 

 Square Round Black Geo Conference Table 

 Chrome Geo Conference Table 

 Black Geo Conference Table 

 6ft Rectangle Mahogany Conference Table 

 8ft Rectangle Mahogany Conference Table 

 10ft Rectangle Mahogany Conference Table 

 6ft Rectangle Granite Conference Table 

 10 Foot Rectangle Granite Conference Table 

 42'' Round Granite Conference Table 

 8 Foot Rectangle Granite Conference Table 

 Manhattan Table with Glass 

Manufacturer -> Manufacturer -> 
CORT Event Furnishings -> Tables -> 
End Tables Meridian End Table 

 Meridian End Table with Orange Glass 

 Orange Nesting End Tables 

 Purple Nesting End Tables 

 Blue Nesting End Tables 

 Wood Grain Nesting End Tables 

 Meridian End Table 

Manufacturer -> Manufacturer -> 
CORT Event Furnishings -> Tables -> 
Training Tables Graphite Computer Table 

 Training Table 

 Training Table Corner 

Manufacturer -> CORT Event 
Furnishings -> Product Display -> 
Etagere Black Etagere 

 Grey Etagere 

Manufacturer -> CORT Event 
Furnishings -> Product Display -> 
Pedestal 24x24x36 Graphite Pedestal 

 24x24x42 Graphite Pedestal 

 30x30x42 Graphite Pedestal 
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Path Name 

Manufacturer -> CORT Event 
Furnishings -> Product Display -
>Podium Black and Grey Kiosk 

 Cherry Lecturn 

Manufacturer -> CORT Event 
Furnishings -> Product Display -> 
Literature Rack Literature Rack 

Textures -> Drapes Drape Amber 

 Drape Aqua 

 Drape Beige 

 Drape Black 

 Drape Blue 

 Drape Burgundy 

 Drape Chocolate 

 Drape Dark Red 

 Drape Golden 

 Drape Green 

 Drape Grey 

 Drape Indigo 

 Drape Lavender 

 Drape Light Blue 

 Drape Light Green 

 Drape Maroon 

 Drape Pink 

 Drape Red 

 Drape Straw 

 Drape White 

Office -> Imperial -> Accessories Card Holder 

Office -> Metric -> Accessories Cup of Pens & Pencils 

 Tissue Box 

 Waste Basket (Round) 

 Waste Basket (Square) 

A/V  -> Lighting Tea Light 

A/V -> Fog Screens Fog Screen 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Architecture Corinthian Column Panel 1 

 Corinthian Column Panel 2 

 Corinthian Column Panel 3 

 Corinthian Column Panel 4 

 Venetian Arch 1 

 Venetian Arch 1B 

 Temple Wall 

 Ancient Ruin 1 

 Ancient Ruin 2 

 Ancient Arches 1 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Ancient Egypt Ancient Egypt 1 
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Path Name 

 Ancient Egypt 2 

 Ancient Egypt 3 

 Temple of Ramses 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Art Mondrian Panel 3 

 Mondrian Panel 4 

 The Departure 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Around the 
World Stonehenge Sunset 

 Paris 1 

 Arabian Nights 1 

 Egypt 1 

 Oktober Bierfest 

 Bavaria 

 Taj Mahal 

 Cape Town 

 Flags Of The World 1 

 Flags Of The World 2 

 Flags Of The World 3 

 Flags Of The World 4 

 World Landmarks 1 

 Ayers Rock 

 Greek Islands 1 

 World Landmarks 2 

 Tower Bridge London 

 Rome Coliseum 

 Machu Picchu 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Pirate Pirate 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Carnival Rio Carnival 1 

 Venetian Carnival 1B 

 Rio Carnival 2 

 Rio Carnival 3 

 Rio Carnival 5 

 Carnival Mask 1 

 Carnival Mask 1B 

 Carnival Mask 2 

 Happy Mardi Gras 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Celebration Fireworks 1 

 Fireworks 2 

 Party 2 

 LOVE 

 Celebration Panel 3 

 Celebration Panel 4 
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Path Name 

 Celebration 1 

 Balloons 1 

 Celebration 2 

 Moonlight Tango 

 Party 

 Celebration 4 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Christmas Christmas Eve 

 Nativity 1 

 Christmas Village 3 

 Christmas Village 3B 

 Merry Christmas 

 Dickens Christmas Street 1 

 Dickens Christmas Street 1B 

 Christmas Tree Panel 1 

 Christmas Tree Panel 1B 

 Christmas Tree Panel 2 

 Christmas Tree Panel 2B 

 Christmas Tree Panel 3 

 Christmas Tree Panel 3B 

 Ye Olde Toy Shoppe 

 Santa's Workshop 

 Santa's Workshop B 

 Dickens Christmas Street 2 

 Christmas Village 7 

 Christmas Village Tree Panel 1 

 Christmas Village Tree Panel 2 

 Christmas Village 6B 

 Christmas Village 6 

 Christmas Village 5 

 Bethlehem 2 

 Bethlehem 3 

 Christmas Village 8 

 Christmas Town Square 1 

 Whoville Christmas 1 

 Whoville Christmas 1B 

 Bethlehem 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Cityscapes Sydney Harbour 

 Johannesburg Skyline 1 

 Johannesburg Skyline 2 

 Chicago Skyline 

 Chicago Skyline B 

 Gotham City Skyline 

 Gotham City Skyline B 

 New York Skyline B 

 San Francisco Skyline 1 
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Path Name 

 San Francisco Skyline 2 

 San Francisco Skyline 3 

 Central Park Spring 

 Central Park Summer 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Casino/Las 
Vegas Las Vegas 1B 

 Las Vegas 1C 

 Las Vegas 1D 

 Las Vegas Showgirls 1 

 Casino 

 Casino B 

 The Sands 

 The Sands B 

 The Dunes Oasis 2 

 The Bellagio 

 The Luxor 

 The Golden Nugget 

 Las Vegas Showgirls 2 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Concepts Concept 1 

 Concept 2 

 Concept 3 

 The Daily News 

 World Jigsaw Puzzle 

 Rubiks Cube 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Cirque Circus 1 

 Circus Days 

 Circus Parade 1 

 Circus Parade 2 

 Circus Parade 3 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Dance I-Dance 1 

 I-Dance 2 

 Fame 

 Fame 2 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Decades 1960's 1 

 Psychedelia 

 Disco 4 

 Back to the Eighties B 

 Gangsters 1 

 Gangsters 1B 

 Harlem Jazz Panel 1 

 Harlem Jazz Panel 2 

 Harlem Jazz Panel 3 
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Path Name 

 History of Flight 

 Decades 1B 

 Decades 1C 

 Decades 2B 

 Tie-Dye 

 Tie-Dye Panel 1 

 Tie-Dye Panel 2 

 Tie-Dye Panel 3 

 Tie-Dye Panel 4 

 Rock and Roll 

 Big Band 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Drapes Venetian Drapes Panel 1 

 Venetian Drapes Panel 2 

 Venetian Drapes Panel 3 

 Venetian Drapes Panel 4 

 Venetian Drapes Panel 5 

 Venetian Drapes Panel 6 

 Venetian Drapes Proscenium 

 Venetian Drapes 4 

 Venetian Drapes Header 1 

 Venetian Drapes Header 2 

 Venetian Drapes Header 3 

 Venetian Drapes Header 4 

 Venetian Drapes Header 5 

 Venetian Drapes Header 6 

 Venetian Drapes Header 7 

 Venetian Carnival Drape 1 

 Venetian Carnival Drape 2 

 Venetian Carnival Drape 3 

 Venetian Carnival Drape 4 

 Venetian Drapes 2 

 Venetian Drapes 6 

 Venetian Drapes 7 

 Venetian Drapes 8 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Elements Fire B 

 Sand 

 Zebra 

 White Daffodils 

 Butterflies 

 Sunflowers 

 Four Seasons 1 

 Lightening Spirit 

 Four Seasons 2 

 Mud Panel 1 

 Mud Panel 2 
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 Mud Panel 3 

 Mud Panel 4 

 Mud Panel 5 

 Mud Panel 6 

 Mud Panel 7 

 Mud Panel 8 

 Poppy Field 

 Poppy Field Panel 1 

 Poppy Field Panel 2 

 Weather Map 

 Weather Elements 

 Sun 

 Snowflakes 1 

 Snowflakes 2 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Entertainment Making Movies 

 Hollywood 1 

 Magic 1 

 Magic 2 

 Moll Show Panel 1 

 Moll Show Panel 2 

 Moll Show Panel 3 

 Band Show Panel 1 

 Band Show Panel 2 

 Dance 1 

 Dance 1B 

 Dance 1C 

 Music Notes 1 

 Music Notes 2 

 Bollywood 

 Motown 

 Dance 2 

 Dance 2B 

 Dance 2C 

 Dance Stars 

 Dance 3 

 Dance 3B 

 Dance 3C 

 Dance Stars 2 

 Dance Awards 2 

 Dance Awards 2C 

 Jazz Greats 

 Jazz Panel 1 - Nina Simone 

 Jazz Panel 2 - Duke Ellington 

 Jazz Panel 3 - Billy Holliday 

 Band Show Panel 3 

 Show Stage 1B 
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 Show Stage 1C 

 Show Stage 2 

 Show Stage 2B 

 Jazzy Panel 1 

 Jazzy Panel 2 

 Jazzy Panel 3 

 Jazzy Panel 4 

 Jazzy Panel 5 

 Jazzy Panel 6 

 Broadway Theatre District 

 Hollywood Sign 2 

 Hollywood Palm Panel 1 

 Hollywood Palm Panel 2 

 Hollywood Palm Panel 3 

 Hollywood Palm Panel 4 

 Hollywood Sign 3 

 Dance Awards Leg 1 

 Dance Awards Leg 2 

 Music Notes 3 

 Music Notes 4 

 Flipping Channels 

 Stars 1 

 Stars 2 

 Stars 3 

 Stars 4 

 Hollywood Sign 4 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Exteriors African Facade 

 Castle Exterior 

 London Pub 

 Theatre Exterior 

 American Diner 

 Paris Cafe 

 Cabaret Paris Exterior 

 Window Strip 1 

 Window Strip 2 

 Cadillac Diner 

 Mann's Chinese Theatre 

 Rick's Cafe Exterior 

 The Cotton Club Exterior 

 Plantation House 

 Castle Exterior 2 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Fairground House of Horror 

 Boardwalk 2B 

 Boardwalk 3B 

 Fairground 1 
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Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Fantasy Fantasy Unicorns 

 Fantasy Forest 1 

 Fantasy Forest 1B 

 Fantasy Icescape 

 Fantasy Lake 1 

 Fantasy Lake 2 

 Fantasy Lake 3 

 Candyland Interior 1 

 Candyland Interior 1B 

 Munchkin Land 

 Land of OZ 

 Witches Castle 

 The Emerald City 

 Candyland 1 

 Candyland 1B 

 Chocolate Factory 

 Crystal Palace 1 

 Candyland 2 

 Candyland 3 

 Emerald City Interior 1 

 Candy Kingdom - Day 

 Candy Kingdom - Night 

 Whoville 

 The Fantastical Circus 

 Fire & Ice 

 Fire & Ice Panel 1 

 Fire & Ice Panel 2 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Gala Awards Gala Awards 2 

 Gala Awards 3 

 Gala Awards 4 

 Gala Awards Leg 1 

 Gala Awards Leg 2 

 Gala Awards Header 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Garden 1 Moonlight Garden 1 

 Moonlight Garden 2 

 Elegant Garden 1B 

 Elegant Garden 1C 

 Garden Hamlet 

 Moonlight Garden Panel 1 

 Moonlight Garden Panel 2 

 Moonlight Garden Panel 3 

 Moonlight Garden Panel 4 

 Monet's Garden 1 

 Hampton Court 
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Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Halloween Halloween 1 

 Graveyard Ghoul 

 Haunted Castle 

 Classic Horror 1 

 Transylvania 1 

 Transylvania 2 

 Transylvania 3 

 Haunted Castle Interior 1 

 Haunted Castle Interior 2 

 Haunted Castle Interior 3 

 Haunted Mansion Interior 1 

 Haunted Mansion Interior 1B 

 Haunted Castle Interior 4 

 Transylvania 4 

 Transylvania 5 

 Transylvania 6 

 Halloween 3 

 Halloween Panel 1 

 Halloween Panel 2 

 Halloween Panel 3 

 Halloween Panel 4 

 Spider Web 1 

 Spider Web Panel 1 

 Spider Web Panel 2 

 Spider Web Panel 3 

 Spider Web Panel 4 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Interiors Diner Interior B 

 Diner Interior C 

 Castle Interior 1 

 Stone Wall - Arch 1 

 Stone Wall - Arch 2 

 Wine Cellar 1 

 The Courtyard 

 Brick Wall 2 

 Brick Wall 3 

 Brick Wall 4 

 Brick Wall Panel 1 

 Brick Wall Panel 2 

 Wine Cellar 2 

 Castle Interior 4 

 Castle Interior 5 

 Victorian Parlour Interior 1 

 Victorian Parlour Interior 1B 

 Victorian Parlour Interior 1C 

 Caves 1 
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 Toys 

 Toys B 

 Toys Room 

 Toys Room B 

 Victorian Parlour Interior 2 

 Victorian Parlour Interior 2B 

 Shopping Mall Interior 

 High School Gymnasium 

 Rick's Cafe Interior 1 

 Rick's Cafe Interior 2 

 Ricks Cafe Wall Panel 1 

 Ricks Cafe Wall Panel 2 

 Ricks Cafe Wall Panel 3 

 Ricks Cafe Wall Panel 4 

 Brick Wall 7 

 Brick Wall Panel 3 

 Victorian Parlour Interior 3 

 Victorian Parlour Interior 3B 

 Victorian Parlour Interior 4 

 Victorian Parlour Interior 5 

 Brick Wall Panel 7 

 Brick Wall Panel 8 

 Ricks Cafe Wall Panel 5 

 Ricks Cafe Wall Panel 6 

 Ricks Cafe Wall Panel 7 

 Ricks Cafe Wall Panel 8 

 Dance Studio Interior 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Medieval Medieval Knight 

 Medieval Knight B 

 Medieval Castle 2B 

 Medieval Forest 2 

 Medieval Forest 1 

 Medieval Garden 1 

 Medieval Garden 2 

 Medieval Joust 

 Medieval Castle Wall 1 

 Medieval Castle Wall Door Surround 

 Medieval Castle Wall 2 

 Medieval Castle Wall Panel 2 

 Medieval Castle Wall Panel 3 

 Medieval Castle Wall Panel 4 

 Medieval Castle Wall Panel 5 

 Medieval Forest 3 

 Medieval Forest 4 
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Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Cabaret De 
Paris 

Cabaret De Paris 1 

 Cabaret De Paris 3 

 Cabaret De Paris 4 

 Cabaret De Paris 5 

 Cabaret De Paris 6 

 Cabaret De Paris Poster 1 

 Cabaret De Paris Poster 2 

 Cabaret De Paris Poster 3 

 Cabaret De Paris Poster 4 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops ->  Mystery & 
Suspense The Deadly Go-Go's 

 Kiss of the Tarantula 

 James Bond 1B 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Nautical Nautical Map 1 

 Nautical Map 2 

 Nautical Map 4 

 The Storm 

 Sunset Marina 

 Sailboat 

 Cruise Ship at Night 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Out of Africa Chobe Sunset 

 Savannah Sunset 4 

 Savannah Sunset 1 

 Savannah Sunset 2 

 Savannah Sunset 3 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Oriental Japanese Print 1 

 Thai Temple 

 Chinese Dragon 1 

 Paddyfields 1 

 Paddyfields 2 

 Oriental Bamboo Panel 1 

 Oriental Bamboo Panel 2 

 Oriental Bamboo Panel 3 

 Oriental Bamboo Panel 4 

 Oriental Bamboo Panel 5 

 Oriental Bamboo Panel 6 

 Oriental Bamboo Panel 7 

 Oriental Bamboo Panel 8 

 Japanese Lake 1 

 Oriental Panel 1 

 Oriental Panel 2 
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 Oriental Panel 3 

 Oriental Panel 4 

 Oriental Panel 5 

 Oriental Panel 6 

 Oriental Panel 7 

 Oriental Panel 8 

 Great Wall of China 

 Oriental Flower Panel 1 

 Oriental Flower Panel 2 

 Oriental Flower Panel 3 

 Oriental Flower Panel 4 

 Oriental Flower Panel 5 

 Oriental Flower Panel 6 

 Oriental Flower Panel 7 

 Oriental Flower Panel 8 

 Oriental Flower Panel 9 

 Oriental Flower Panel 10 

 Oriental Flower Panel 11 

 Oriental Flower Panel 12 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Sahara Sahara 1 

 Sahara 2 

 Moroccan Market 1 

 Sahara 4 

 Sahara 3 

 Sahara Sunset 

 Sahara Sunset B 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Scenic Scenic Mountains 

 Desert Dunes 

 Park Landscape 1 

 Aurora Borealis 2 

 Aurora Borealis 3 

 Aurora Borealis 4 

 Cape Winelands 1 

 Cape Winelands 2 

 Highway 

 Park at Night 

 Park Landscape 2 

 Farmyard 

 Schoolhouse 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Shanty Town Shanty Town 1 

 Shanty Town 3 

 Shanty Town 6 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Clouds Clouds 1 
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 Clouds 3 

 Clouds 4 

 Enchanted Sky 1B 

 Sunset Sky 2 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Sports Baseball 1 

 Basketball 

 Gridiron 

 Ice Hockey 

 Horse Race 1 

 Golf Course 1 

 Formula 1 

 World Cup Soccer 

 Golf Course 2 

 Tennis 

 Olympics 1 

 Big Surf 

 Skateboard 

 Tailgate Party 

 Horse Race 2 

 Speed Machine 

 F1 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Space/Sci-Fi Zodiac 

 Pink Planet 1 

 Pink Planet 2 

 Sci-Fi City 

 Planet Earth 

 Space Vortex 

 Space Vortex B 

 Techno Space 1 

 Techno Space 3 

 Techno Space 4 

 Starfield 2 

 Techno Space 5 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Streets Of The 
World Piccadilly Circus 

 South Beach - Miami B - 3M 

 St. Mark's Square - Venice 

 St. Mark's Square A 

 St. Mark's Square B 

 St. Mark's Square C 

 Las Vegas Strip 1 - Bellagio 

 Las Vegas Strip 2 - MGM Grand 

 Times Square - Small 

 Las Vegas Strip 3 - Paris 
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 42nd St - 1B 

 42nd St - 2B 

 Paris Montmartre 2 

 Old London Street 1 

 Old London Street 2 

 Town Square 2 

 Town Square 3 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Tropical Beach Tropical Beach 1 

 Tropical Beach 2 

 Tropical Beach Sunset 

 Tropical Beach Sunset B 

 Tropical Beach 4 

 Tropical Beach 6 

 Palm Tree Panel 1 

 Palm Tree Panel 2 

 Palm Tree Panel 3 

 Palm Tree Panel 4 

 Palm Tree Panel 5 

 Palm Tree Panel 6 

 Palm Tree Panel 7 

 Palm Tree Panel 8 

 Tropical Pool 

 Sunset Tiki 

 Sunset Tiki C 

 Tropical Beach Sunset Vignette 

 Aloha 

 Key West Beach 1 

 Key West Beach 2 

 Key West Beach 3 

 Key West Beach Panel 1 

 Key West Beach Panel 2 

 Key West Beach Panel 3 

 Key West Beach Panel 4 

 Key West Beach Panel 5 

 Key West Beach Panel 6 

 Palm Tree Panel 9 

 Palm Tree Panel 10 

 Palm Tree Panel 11 

 Palm Tree Panel 12 

 Palm Tree Panel 13 

 Palm Tree Panel 14 

 Palm Tree Panel 15 

 Palm Tree Panel 16 

 Palm Tree Panel 17 

 Palm Tree Panel 18 

 Palm Tree Panel 19 
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 Palm Tree Panel 20 

 Palm Tree Panel 21 

 Palm Tree Panel 22 

 Palm Tree Panel 23 

 Palm Tree Panel 24 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Tropical Jungle Mayan Ruins 1 

 Mayan Pyramid 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Tuscany Tuscany 3 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Undersea Undersea Cave 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> USA USA 1 

 US Flag 

 Stars and Stripes 

 Mt Rushmore 

 American Indian 

 The Bayou 1 

 The Bayou 2 

 The Bayou 3 

 MASH 

 Red White and Blue 

 Red White and Blue Panel 1 

 Red White and Blue Panel 2 

 Red White and Blue Panel 3 

 Red White and Blue Panel 4 

 Red White and Blue Panel 5 

 Red White and Blue Panel 6 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Venice Canals of Venice 1 

 Canals of Venice 2 

 Moonlight in Venice 1 

 Moonlight in Venice 2 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Winter 
Wonderland Winter Wonderland 1B 

 Winter Wonderland 2B 

 Winter Wonderland 3B 

 Winter Wonderland 4C 

 Winter Wonderland 7B 

 Winter Wonderland 8B 

 Winter Wonderland 9B 

 Winter Wonderland 4B 

 Central Park Winter 1B 

 Central Park Winter 2 

 Central Park Winter 2B 
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 Winter Cottage 1 

 Winter Village 1 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Wild West Buffalo Bill's Wild West 

 The Great Train Robbery 

 Bandits 

 The Old West 3 

 The Old West 5 

 The Old West 1 

 The Great Train Robbery 2 

 Sunset Barn 

 Sunset Barn C 

 Sunset Barn Panel 1 

 Sunset Barn Panel 2 

 Sunset Cowboy 

 Sunset Cowboy C 

Manufacturer -> Backdrops Fantastic -
> Theme Backdrops -> Specialty 
Backdrops Black Backdrop 1 

 White Backdrop 1 

 Key West Beach Panel 2 

 Key West Beach Panel 3 

 Key West Beach Panel 4 

Manufacturer -> Rose Brand -> Fabrics Chenille flat apple 

 Chenille flat black 

 Chenille flat brick 

 Chenille flat brown sugar 

 Chenille flat gold 

 Chenille flat grey stone 

 Chenille flat india ink 

 Chenille flat pine 

 Chenille flat purple 

 Chenille flat walnut 

 Marvel flat bermuda 

 Marvel flat black 

 Marvel flat brick 

 Marvel flat cashmere 

 Marvel flat claret 

 Marvel flat cornflower 

 Marvel flat crème 

 Marvel flat dove 

 Marvel flat espresso 

 Marvel flat fern 

 Marvel flat gold 

 Marvel flat grape 

 Marvel flat hunter 

 Marvel flat jezebel 
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 Marvel flat kodiak 

 Marvel flat navy 

 Marvel flat ocean 

 Marvel flat peacock 

 Marvel flat pewter 

 Marvel flat plum 

 Marvel flat rose 

 Marvel flat rouge 

 Marvel flat sienna 

 Marvel flat wedgewood 

 Marvel flat white 

 Marvel flat wine 

 Tergalet flat bamboo 

 Tergalet flat black 

 Tergalet flat blaze 

 Tergalet flat cocoa 

 Tergalet flat iguana 

 Tergalet flat indigo 

 Tergalet flat pewter 

 Tergalet flat regal purple 

 Tergalet flat silver 

 Tergalet flat snow 

 Tergalet _flat_vino 

 

Library Updates Vivien 2011 
 

The following updates were made to the library in Vivien 2011: 

Path Name 

People -> Mannequins -> People with 
Objects Person at Drum Kit 

 Person at Grand Piano 

 Person at Keyboard 1 

 Person at Keyboard 2 

 Person at Keyboard 3 

 Person at Keyboard 4 

Objects -> Imperial/ Metric -> Musical 
Items -> Keys Grand Piano 

 Keyboard 

 Keyboard on Stand 

 Upright Piano 

Objects -> Imperial/ Metric -> Musical 
Items -> Percussion Drum Kit 

A/V -> Video Projectors Small Video Projector 

 Medium Video Projector 

 Large Video Projector 
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Fixes – Vivien 2011 
The following issues were resolved in the Vivien 2011: 

1. Bug description: Miscellaneous issues in the Drawing Wireframe’s Align tool. 
Fix:  The tool has been updated with multiple fixes to improve its reliability and 
accuracy.  

2. Bug description: Saturation in the Colour section of the Light Tool (Lighting 
Wireframe, Lighting Quad, Virtual View) was set to white by default, which meant 
that the saturation slider would have to be set to grey before a colour could be 
selected for a fixture. 
Fix:  The saturation slider is now set to grey by default. 

3. Bug description: Group selection and control in the Vivien Layouts tab was 
problematic. 
Fix:  Group selection and control in the Vivien Layouts tab has been improved. 

4. Bug description: Vivien would crash intermittently while working in the Layouts 
or Spreadsheets tabs. 
Fix:  This issue has been resolved. 

5. Bug description: There were content visibility issues reported in the Cell Format 
window on the Spreadsheets tab.  
Fix:  This issue has been resolved. 

6. Bug description: Cells with word wrap enabled were not displaying properly on 
the Spreadsheets tab.  
Fix:  This issue has been resolved. 

 
Known Issues 
 

XSLX files created from Spreadsheets or Event Resources tab will not open in 
OpenOffice 

Files with the extension .xslx that are created in the Spreadsheets or Event Resources 
tabs of Vivien will not open in OpenOffice. However, these files will open with Microsoft 
Excel 2007.  

 

Contacting Technical Support 
Read the online documentation and visit the www.viviendesign.com web site before 
contacting Technical Support. Contact Technical Support at the following location: 
 
CAST Software 
Technical Support 
35 Ripley Avenue, Unit 1  
Toronto, ON M6S 3P2 
Canada 
Toll Free Tel: +1.877.989.2278 
Fax: +1.416.597.9594 
Email: techsupport@cast-soft.com 
Web site: www.viviendesign.com 

http://www.viviendesign.com/
http://www.viviendesign.com/
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Copyright Information 
 

© The CAST Group of Companies Inc. 2004-2011. All rights reserved. 
35 Ripley Avenue, Unit 1  
Toronto, Ontario 
Canada M6S 3P2 
 
"Vivien” and “CAST Software” are trademarks of the CAST Group of Companies Inc. 
Other brands or products are the trademarks or registered trademarks of their respective 
holders and should be treated as such. 


